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Introduction
TheCrestron HD-WP-4K-401-C enables the simultaneous display of up to four video sources on a
single HD, Ultra HD, or 4K display. Parallel HDMI® andHDBaseT® outputs provide flexible
connectivity for theHDMI display and other equipment. Input sources up to 4K are supported via
four HDMI inputs. Fully automatic operation and out-of-the-box functionality enable usewithout
a control system, while enhanced operation and custom functionality can be attained through
integration with a control system. Easy setup and configuration of theHD-WP-4K-401-C is
enabled using aweb browser or the front panel controls.

Video windowing enhances the presentation and collaboration capabilities of meeting spaces,
allowingmultiple presentation sources to be connected and displayed together on screen. The
ability to connect up to four Crestron Connect It™ cable caddies (TT-100Series) directly to the
HD-WP-4K-401-C affords a perfect multi-window collaboration solution for huddle rooms and
classrooms.

This guide provides information about the out-of-the box functionality of theHD-WP-4K-401-C
as well as configuration of theHD-WP-4K-401-C using theweb interface and the front panel
OLED display. For installation information, refer to theHD-WP-4K-401-CDOGuide (Doc. 7900).

https://www.crestron.com/getmedia/0493fcc1-4c14-4ed1-8d08-4fd6afe6a0e7/mg_do_hd-wp-4k-401-c_1
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Using the Out-of-the-Box Functionality
Out-of-the box functionality automatically enables the simultaneous display of all connected
audio/video sources on an HDMI display without the need for additional programming or
configuration. If one source is connected, one full-screen windowappears on the display. If two
sources are connected, two side-by-sidewindows of equal size appear on the display and are
vertically centered. If three sources are connected, threewindows of equal size appear on the
display (two side-by-sidewindows above one centeredwindow). If four sources are connected,
four windows of equal size appear on the display. The following illustration shows the one-, two-,
three-, and four-window configurations.

Window Configurations Using Out-of-the-Box Functionality

NOTE: Audio is transmitted only when a single full-screen image is displayed in a singlewindow.
If multiplewindows are displayed, the audio from all sources is muted.
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To display sources using out-of-the-box functionality:

1. Connect up to two HDMI displays to theHD-WP-4K-401-C as required for the application.
OneHDMI display connects to theHDMI output of theHD-WP-4K-401-C. The other HDMI
display connects to theHDBT (HDBaseT) output of theHD-WP-4K-401-C via aDM8G+®
receiver, DigitalMedia™ switcher, or DM-DGE-200-CDigital Graphics Engine. TheHDBT
output can also connect directly to any display device equippedwith an HDBaseT input.

2. Connect up to four HDMI sources to theHDMI inputs of theHD-WP-4K-401-C. All
connected sources appear on the display in the correspondingwindow configuration.

NOTE: If both theHDMI andHDBT outputs are connected, theHDBT output display
mirrors theHDMI output display.

3. (Optional) Connect up to four Crestron Connect It cable caddies to theUSB input ports of
theHD-WP-4K-401-C. Press a button on a cable caddy while the LED is blue to display the
associated source as a full-screen windowon the display. Press the button again while the
LED is green to allow the display to return to the previous configuration (two, three, or four
windows).
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Using theWeb Interface
Built-in web pages of theHD-WP-4K-401-C allow video windowing, on-screen display, input,
output, network, and device settings to be configured. In addition, status information about the
HD-WP-4K-401-C can be viewed.

Accessing theWeb Interface
The following table lists various operating systems and the correspondingweb browsers that are
supported by theHD-WP-4K-401-Cweb interface.

Operating System and SupportedWeb Browsers for the HD-WP-4K-401-C

Operating System Supported Web Browsers

Windows® operating system Internet Explorer® web browser, version 9 and later

Chrome™ web browser, version 31 and later

Firefox® web browser, version 31 and later

macOS® operating system Safari® web browser, version 6 and later

Chrome web browser, version 31 and later

Firefox web browser, version 31 and later

iOS® operating system Safari web browser, version 6 and later

Chrome web browser, version 31 and later

Android™ operating system Chrome web browser, version 31 and later

To access theweb interface, do either of the following:

l Open aweb browser directly. Refer to Opening aWebBrowser Directly (on the facing page)
for additional information.

l Open aweb browser within theCrestron Toolbox™ application. Refer to Opening aWeb
Browser within theCrestron Toolbox Application (on the facing page) for additional
information.
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Opening a Web Browser Directly
To access theweb interface by opening aweb browser directly:

1. Note the IP address that appears on the front panel OLED display.

NOTE: After power is applied to theHD-WP-4K-401-C, the IP address appears on the
front panel OLED display.

2. Open aweb browser.

3. Go to the IP address of theHD-WP-4K-401-C.

Either of the following occurs:

l If theweb interface is being accessed for the first time, a privacy error may occur.
Depending on theweb browser that is being used, the privacy message varies.
Perform the steps necessary to proceed to theHD-WP-4K-401-Cweb interface. The
Login page of theHD-WP-4K-401-C then opens.

l The Login page of theHD-WP-4K-401-C opens.

For information about the Login page, refer to Logging In to theHDWP 4K-401-C (on the
next page).

Opening a Web Browser within the Crestron Toolbox Application
To access the user interface by opening aweb browser within theCrestron Toolbox application:

1. Open theCrestron Toolbox application.

2. From the Tools menu, select DeviceDiscovery Tool.

NOTES:

l You can also access theDeviceDiscovery Tool by clicking theDeviceDiscovery Tool

button ( ) in the toolbar.

l The security software running on the computer may send a program alert regarding
the attempt of theCrestron Toolbox application to connect to the network. Allow the
connection so that theDeviceDiscovery Tool can be used.

3. From the device list on the left-hand side of the screen, double-click HD-WP-4K-401-C.

Either of the following occurs:

l If theweb interface is being accessed for the first time, a browser windowopens that
may display a privacy error. Depending on theweb browser that is being used, the
privacy message varies. Perform the steps necessary to proceed to theHD-WP-4K-
401-Cweb interface. The Login page of theHD-WP-4K-401-C then opens.

l The Login page of theHD-WP-4K-401-C opens.

For information about the Login page, refer to Logging In to theHDWP 4K-401-C (on the
next page).
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Logging In to the HDWP 4K-401-C
The Login page enables login to theHD-WP-4K-401-C.

Login Page

To log in to theHD-WP-4K-401-C:

1. Enter the user nameand password. The default user name is admin, and the default
password is admin.

NOTES:

l The user nameand password are case sensitive.

l For enhanced security, it is recommended that the user nameand password be
changed. For additional information, refer to Changing theUsernameand
Password (on page 32).

l If the user nameand password are changed and the factory default settings are
later restored, the user nameand passwordwill revert to the default setting, which
is admin.

2. Click Submit.

The Status page opens. For an overview of theweb interface, refer to Navigating theWeb
Interface (on the facing page).
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Navigating theWeb Interface
Theweb interface provides a navigation bar and built-in web pages of theHD-WP-4K-401-C.

Web Interface (Sample Status Page of HD-WP-4K-401-C Shown)

The navigation bar provides the following tabs on the left side of theweb interface:

l Status—Refer to Viewing Device Status Information (on the next page) for additional
information.

l Windowing—Refer to ConfiguringWindowing Settings (on page 10) for additional
information.

l On-Screen Display—Refer to Configuring On-Screen Display Settings (on page 12) for
additional information.

l Input—Refer to Configuring Input Settings (on page 15) for additional information.

l Output—Refer to Configuring Output Settings (on page 20) for additional information.

l Network—Refer to Configuring Network Settings (on page 28) for additional information.

l Device—Refer to Configuring Device Settings (on page 29) for additional information.
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Viewing Device Status Information
General information, such as model name, serial number, and firmware version of theHD-WP-4K-
401-C, can be viewed. The current network settings as well as control system connection settings
can also be viewed.

To view device status information:

In the navigation bar, click Status. The Status page opens.

NOTE: The Status page automatically opens after logging in to theHD-WP-4K-401-C.

Sample Status Page

The Status page displays the following information about theHD-WP-4K-401-C:

l General information:
o Model (HD-WP-4K-401-C)
o Serial Number
o Firmware Version

l Network-related information:
o Hostname

NOTE: The default hostname is HDWP401C-xxxxxx, where xxxxxx consists of the
last six characters (excluding punctuation) of theMAC address of the device.

o IP Address
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o Subnet Mask
o Default Gateway
o MACAddress

l Control system connection information:
o Address of the control system
o IP ID of theHD-WP-4K-401-C
o Port number of theHD-WP-4K-401-C

NOTE: The default port number is 41794.

o Status (Online or Offline)
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Configuring Windowing Settings
Video windowing enables up to four video sources to be displayed simultaneously on a single
display.

To configure video windowing:

1. In the navigation bar, clickWindowing. TheWindowing page opens.

Windowing Page

2. In the Layout section of the screen, select one of the followingwindowingmodes:

l Automatic: (Default setting) Displays the detected inputs as follows:
o Displays four detected inputs as a quad view consisting of four equal-sized

windows positioned as two side-by-sidewindows above two side-by-side
windows

o Displays three detected inputs as three equal-sizedwindows positioned as two
side-by-sidewindows above one centeredwindow

o Displays two detected inputs as two equal-sized and vertically centered
windows

o Displays one detected input as a full-screen image
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l Full Screen: Displays any single input as a full-screen image

NOTE: Inputs 1 and 2 allow sources with resolutions up to DCI 4K to be displayed at
the full resolution when in full-screenmode as long as the resolution is supported by
the display device. Inputs 3 and 4 accept sources with a resolution up to DCI 4K;
however, the full-screen output resolution for inputs 3 and 4 is automatically
downscaled to 1080p.

l Picture-in-Picture (PIP): Displays any single input as a full-screen imagewith any
other input as a scalable inset window that can be positioned as desired (refer to step
6 below for information about PIP options)

l Side-by-Side: Displays any two inputs as two equal-sized and vertically centered
windows

l Quad View:Displays four inputs as four equal-sizedwindows positioned as two side-
by-sidewindows above two side-by-sidewindows

l 3-up: Displays three inputs as three equal-sizedwindows positioned as two side-by-
sidewindows above one horizontally centeredwindow

l 3-down: Displays three inputs as three equal-sizedwindows positioned as two side-
by-sidewindows below one horizontally centeredwindow

l 3 Small Left, Large Right: Displays four inputs as three equal-sizedwindows on the
left and one larger vertically centeredwindowon the right

l 3 Small Right, Large Left: Displays four inputs as three equal-sizedwindows on the
right and one larger vertically centeredwindowon the left.

3. (Applicable to all Layout modes except Automatic mode) In the Source Selection section of
the page, select the desired source to be displayed in awindowas applicable to the
windowing layout or select Mute.

If Mute is selected, no video will be sent to the selectedwindow.

4. In the Aspect Ratio Selection section of the page, select the aspect ratio for each of the
displayedwindows: Auto, Full, 4:3, 16:9, or 16:10.

If Auto is selected, the aspect ratio of the source is maintained.

5. In the Audio Selection section of the page, select the sourcewhose audio is to be unmuted or
select Auto (default setting).

If Auto is selected, audio is transmitted only when a single full-screen image is displayed in a
singlewindowor when the layout is in PIP mode. If multiplewindows are displayed, the audio
from all sources is muted.
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6. (Applicable only to PIP layout) In the PIP Options section of the page:

a. In the Location drop-down list, select one of the following options to position the
smaller windowwithin the larger window: Upper Left, Center Left, Lower Left, Upper
Right, Center Right, Lower Right, or Custom. The default setting is Upper Left.

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in pixels to
position the smaller window, and then click the Save button.

b. In the Size drop-down list, select one of the following options to set the size of the
smaller windowwithin the larger window: Small (10%), Medium (20%), Large (30%),
or Custom. The default setting is Medium (20%).

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in pixels to
set the size of the smaller window, and then click the Save button.

7. In theWindowTitles section:

a. Enable or disablewindow titles by clicking the Enabled or Disabled radio button,
respectively. By default, the Enabled radio button is selected.

b. (Applicable only whenWindowTitles is set to Enabled)Do the following:

i. Select one of the following options to specify thewindow title: Show Input
nameand Resolution, Showonly Input name, or Showonly Resolution. The
default setting is Show Input nameand Resolution.

ii. In the Location drop-down list, select one of the following options to position
window titles: Upper Left, Center Left, Lower Left, Upper Right, Center Right, or
Lower Right. The default setting is Upper Left.

iii. In the Font Size drop-down list, select one of the following options to set the
size of thewindow titles: Small (10%), Medium (20%), Large (30%). The default
setting is Medium (20%).

Configuring On-Screen Display Settings
A custom text label can be set for theHDMI video output. The text can be positioned at a
designated location on screen to display a static label or a dynamic pop-upmessage sent from the
control system. A custom photo or logo image can also be uploaded to appear at a designated
location on the screen.

To configure on-screen display settings:

In the navigation bar, click On-Screen Display. TheOn-Screen Display page opens.
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On-Screen Display Page

Refer to the following sections for information about text overlay and image overlay
configuration.

Configuring Text Overlay Settings
In the Text Overlay section of theOn-Screen Display page, configure text overlay settings:

1. Enable text overlay by clicking the Enable radio button. By default, theDisable radio button
is selected, preventing text from being overlaid on the display device.

2. In the Text to display text box, enter the desired text, and then click the Save button.

3. In the Location drop-down list, select one of the following options to position the text on the
display device: Upper Left, Center Left, Lower Left, Upper Right, Center Right, Lower Right,
or Custom. The default setting is Upper Left.

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in pixels to
position the text on the display, and then click the Save button.

4. In the Font Size drop-down list, select one of the following: Small (10%), Medium (20%), and
Large (30%). The default setting is Medium (20%).

5. In the Font Color drop-down list, select one of the following options to set the color of the
text overlay font:White, Yellow, Cyan, Green, Magenta, Red, Blue, Black, or Custom. The
default setting is White.

If Custom is selected, enter theHEX color value into the text box and then press the Save
button.
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6. Adjust the Font Transparency slider to raise or lower the transparency of the text overlay
font. Font transparency ranges from 0% to 100%.

NOTE: Font transparency is not supportedwhen a custom font color is used.
Transparency is enabled only when a preset font color is selected.

7. In the BackgroundColor drop-down list, select one of the following options to set the color
that appears behind the text overlay:White, Yellow, Cyan, Green, Magenta, Red, Blue, Black,
or Custom. The default setting is White.

If Custom is selected, enter theHEX color value into the text box and then press the Save
button.

8. Adjust the Background Transparency slider to raise or lower the transparency of the text
overlay background. Background transparency ranges from 0% to 100%.

NOTE: Background transparency is not supportedwhen a custom background color is
used. Transparency is enabled only when a preset font color is selected.

Configuring Image Overlay Settings

NOTE: The image file to be uploaded for on-screen display must be a BMP, JPEG, JPG, or TIFF
file. In addition, the image filemust have amaximum resolution of 1920 x 1080pixels and be an 8-
bit color image.

In the ImageOverlay section of theOn-Screen Display page, configure image overlay settings:

1. Enable image overlay by clicking the Enable radio button. By default, theDisable radio
button is selected, preventing an image from being overlaid for on-screen display.

2. Specify the image path type by selecting the Local or Remote radio button:

l If the image is located on the hard drive of the device from which theHD-WP-4K-401-
Cweb interface is accessed, select Local (default setting).

l If the image is located on a device other than the local hard drive, select Remote.

3. Specify the path to the image by doing either of the following:

l If the image path type is set to Local, click the Browse button, navigate to the desired
image file, and then click Open. The path and filenameappear in the Path field. Click
the Load button to upload the image file from the local device to theHD-WP-4K-401-
C.

l If the image path type is set to Remote, enter theURL (HTTP or HTTPS) to access the
image file from a remote location. Click the Load button to upload the image file from
the remote location to theHD-WP-4K-401-C.

4. In the Location drop-down list, select one of the following options to position the image on
the display device: Upper Left, Center Left, Lower Left, Upper Right, Center Right, Lower
Right, or Custom. The default setting is Upper Left.
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If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in pixels to
position the image on the display device.

5. Enable ImageBlendColor by clicking the Enable radio button. A color picker containing up to
256 colors sampled from the image is activated. Select up to four image blend colors that
will result in 100% transparency wherever the image blend colors are used in the image,
enabling the background video source to be visible in those areas of the image.

By default, theDisable radio button is selected.

Configuring Input Settings
Configure all inputs on the Input page or individually on the input-specific pages (Input 1, Input 2,
Input 3, and Input 4). The desired EDID can be selected and sent to the inputs. Built-in EDID files
are available for selection, and custom EDID files can also be selected. In addition, inputs can be
renamed andHDCP (High-bandwidth Digital Content Protection) support can be configured.

Configuring Inputs on the Input Page
To configure inputs on the Input page:

1. In the navigation bar, click Input. The Input page opens.

Input Page
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2. Determinewhether a built-in EDID file or a custom EDID file is to be sent to one or more
inputs. If a custom EDID file is desired, continuewith step 3; otherwise, skip step 3 and
proceed to step 4.

3. (For loading of custom EDID files only) In theGlobal EDID section of the page, load the
desired custom EDID file:

a. Click the Browse button located to the right of the LoadCEDID file field.Windows
Explorer opens.

b. Navigate to the desired EDID file (*.cedid), select the file, and then click theOpen
button.

The selected EDID file appears in the LoadCEDID file field.

c. Click the Load button. A prompt appears asking for confirmation that the EDID file
be uploaded to the input device.

d. Click theOK button. The following occurs:

l In theGlobal EDID section of the page, the custom EDID filename is added to
the Send EDID to All inputs drop-down list.

l In the Inputs section of the page, the custom EDID filename is added to the
EDID drop-down lists.

4. Configure the inputs as follows:

a. (Optional) In theGlobal EDID section of the page, globally apply the sameEDID to all
inputs simultaneously:

i. In the Send EDID to All inputs drop-down list, select the desired built-in EDID
file or a custom EDID file. The built-in EDID files are as follows:

DMDefault 4k 30Hz 2ch (Default setting)
DMDefault 1080p60 2ch
Laptop 16x10 1280x800 2ch
Laptop 16x10 1920x1200 2ch
Laptop 16x9 1080p50 2ch
Laptop 16x9 1080p60 2ch
LaptopWidescreen 2ch
Consumer 4k 25Hz 3D HBR
Consumer 4k 30Hz 3D HBR
Consumer 1080p50 3D HBR
Consumer 1080p50HBR
Consumer 1080p60 3D HBR
Consumer 1080p60HBR
Consumer 720p50HBR
Consumer 720p60HBR
Copy HDMI Output
Copy HDBTOutput

NOTE: Selecting Copy HDMI Output or Copy HDBTOutput copies the EDID
from the output to all of the inputs.
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ii. Click the Apply to All button. The selected EDID is automatically sent to all
inputs and appears in the EDID drop-down list for all inputs in the Inputs
section of the page.

b. In the Inputs section of the page, configure each input as follows:

NOTE: For each input, the Sync icon denotes whether a source is detected at the
input. If a source is detected, the icon is green. If no source is detected, the icon is
gray.

i. In theName text box, rename the input if desired.

ii. If an EDID other than theGlobal EDID is to be assigned, select the desired
EDID in the EDID drop-down list.

iii. In theHDCP Support drop-down list, select HDCP 2.2, HDCP 1.4, or Disabled.
The default setting is HDCP 2.2.

iv. Do one of the following:

l For each input, click Save to save the current Name, EDID, andHDCP
Support entries for the corresponding input. (Clicking Revert goes back
to the previous settings without saving the current entries.)

l Click Save All to save all unsaved entries.

c. In the TT-100Support section of the page, select the TT-100mode to determine how
theHD-WP-4K-401-C is to interpret button presses on the connected Crestron
Connect It cable caddies (TT-100Series):

l Quick Selection: (Default setting) Pressing a button on a cable caddy while the
LED is blue causes the input to be displayed in Full Screen windowing layout
mode and changes the color of the LED to green. Pressing the button again
while the LED is green causes the display to return to the previously selected
windowing layout mode. For example, if thewindowing layout mode is set to
Quad View, pressing a button on a cable caddy while the LED is blue causes the
input to be displayed in Full Screen windowing layout mode and changes the
color of the LED to green. Pressing the button again while the LED is green
causes thewindowing layout mode to return the display to Quad Viewmode.
(Refer to ConfiguringWindowing Settings (on page 10) for information about
windowing layout modes.)

l Standard: Operates according to the SIMPL program (refer to the SIMPL
Windows help file for information)

To delete a custom EDID file, do the following in theGlobal EDID section of the page:

NOTE:Only custom EDID files can be deleted. Built-in EDID files cannot be deleted.

1. In the Send EDID to All inputs drop-down list, select the custom EDID file to be deleted.

2. Click theDelete button.

TheDelete EDID message box appears, asking for confirmation that the EDID file be
removed.
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3. Click the Yes button to delete the EDID.

TheDelete EDID message box appears indicating success.

4. Close themessage box by clicking the X in the upper right-hand corner of the box.

The custom EDID file is deleted from the Send EDID to All inputs drop-down list and also from
each individual EDID drop-down list in the Inputs section of the page.

Configuring Inputs on Input-Specific Pages
To configure a specific input and to view detailed information about the selected EDID and about
the input signal:

1. In the navigation bar, click Input and then click the desired input: Input 1, Input 2, Input 3, or
Input 4.

The Input page opens for the corresponding input.

Input-Specific Page (Sample Input 1 Page Shown)

2. In the Input Settings section of the page:

a. In theName text box, rename the input if desired, and then click the Save button.

b. In theHDCP Support drop-down list, select HDCP 2.2, HDCP 1.4, or Disabled. The
default setting is HDCP 2.2.

3. In theHID Control section of the page, observe the status of the connection of theCrestron
Connect It cable caddy to theUSB port on theHD-WP-4K-401-C:

l Agreen icon indicates that a Crestron Connect It cable caddy is detected.

l Agray icon indicates that a Crestron Connect It cable caddy is not detected.
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4. In the EDID section of the page:

a. (Optional) Upload a custom EDID:

i. Click the Browse button located to the right of the LoadCEDID file field.
Windows Explorer opens.

ii. Navigate to the desired EDID file (*.cedid), select the file, and then click the
Open button.

The selected EDID file appears in the LoadCEDID file field.

iii. Click the Apply EDID button.

A prompt appears asking for confirmation that the EDID file be uploaded to
the device.

iv. Click OK. Themessage "Loading" appears. If the upload is successful, the
message "CEDID Successfully Loaded" appears.

In addition, the custom EDID file is added to the Select drop-down list.

v. Continuewith step 4b.

b. In the Select drop-down list, select the desired built-in or custom EDID. Click Save to
save the EDID selection.

To delete a custom EDID file, do the following in the EDID section of the page:

NOTE:Only custom EDID files can be deleted. Built-in EDID files cannot be deleted.

1. In the Select drop-down list, select the custom EDID file to be deleted.

2. Click theDelete button.

The Input 1, Input 2, Input 3, and Input 4 pages also display information about the selected EDID
and about the input signal:

l TheCurrent EDID section of the page displays the name of the current EDID. To viewmore
details, click MoreDetails. To view fewer details, click Fewer Details.

l The Input Signal section of the page displays the following information:
o Sync Detected: Specifies whether a source is detected at the input:

n Agreen icon indicates that a source is detected.

n Agray icon indicates that a source is not detected.
o Resolution: Specifies the current resolution of the input signal
o HDCP: Specifies whether HDCP is active or inactive

To view additional details about the input signal, click MoreDetails. To view fewer details about the
input signal, click Fewer Details.
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Configuring Output Settings
TheOutput page allows resolution, underscan, and analog audio settings to be set for theHDMI
andHDBT (HDBaseT) outputs. In addition, output settings and automatic power settings can be
configured on an output-specific basis for theHDMI andHDBT outputs. Information about the
connected display and output signal can also be viewed.

Configuring Outputs on the Output Page
To configure outputs on theOutput page:

1. In the navigation bar, click Output. TheOutput page opens.

Output Page

2. In theOutput Settings section of the page:

a. In the Resolution drop-down list, select the desired output resolution. The available
selections are listed below.

NOTE: In the following list, RB denotes Reduced Blanking.

Auto (Recommended) 1080p50
640x480@60 1080p60
480i 1920x1200@60RB
480p 2048x1080@24
576i 2048x1152@60RB
576p 2048x1080@60
800x600@60 1792x1344@60
848x480@60 1856x1392@60
1024x768@60 1920x1440@60
720p@50 2048x1536@60
720p@60 2560x1080@60
1280x768@60 2560x1440@60
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1280x768@60RB 2560x1600@60RB
1280x800@60 3840x2160@24
1280x800@60 RB 3840x2160@25
1280x960@60 3840x2160@30
1280x1024@60 4096x2160@24
1360x768@60 4096x2160@25
1366x768@60 4096x2160@30
1366x768@60RB 1680x720@24
1400x1050@60 1680x720@25
1400x1050@60RB 1680x720@30
1440x900@60 1680x720@50
1440x900@60RB 1680x720@60
1600x900@60RB 2560x1080p24
1600x1200@60 2560x1080p25
1680x1050@60 2560x1080p30
1680x1050@60RB 2560x1080p50
1080i50 2560x1080p60
1080i60
1080p24

The default setting is Auto (Recommended), which specifies the preferred resolution
of the connected display. If both theHDMI output and theHDBT output are
connected, the resolution of theHDMI output takes precedence.

b. In theUnderscan drop-down list, select one of the following options to set the
underscanmode, which reduces the image size by the specified percentage so that the
entire video frame is displayed:

l 0% (default setting)

l 2.5%

l 5%

l 7.5%

l Custom

If Custom is selected, enter a valid value in theUnderscan text box. Valid values range
from 0–10% in increments of 0.1%. To save the custom underscan setting, click the
Set button.
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3. In the Analog Audio Settings section of the page:

a. Mute or unmute the audio output by clicking the Volume button. By default, audio is
unmuted and is set to 0 dB.

b. If audio is unmuted, adjust the volume level as desired by dragging the Volume slider
to the left or to the right. The volume decreases when the slider is dragged to the left
and increases when the slider is dragged to the right. Available values range from -80
dB to 20 dB in increments of 0.5%.

c. To set the audio delay so that the audio is in sync with the video, do either of the
following:

l Drag theDelay slider to the left or to the right. TheDelay text box displays the
value set by theDelay slider.

l Enter the desired value in theDelay text box. Valid values range from 0ms to
150ms. The default setting is 0ms. TheDelay slider adjusts to the value entered
in theDelay text box.

TheOutput page also displays information about the connected display and output signal for both
theHDMI andHDBT outputs:

l TheConnectedDisplay section of the page displays the following:
o Sink Detected: Specifies whether theHDMI andHDBT signal is detected by the

connected display (Yes or No)
o Manufacturer: Specifies the name of themanufacturer of the connected display
o Name: Specifies themodel name of the connected display
o Serial Number: Specifies the serial number of the connected display

l TheOutput Signal section of the page displays the following:
o Transmitting: Specifies whether theHDMI andHDBT outputs are transmitting a

signal to the connected display:

n Agreen icon indicates that the output is transmitting a signal.

n Agray icon indicates that the output is not transmitting a signal.
o Resolution: Specifies the current resolution of the output
o HDCP: Specifies theHDCP version (1.4 or 2.2) or inactive

Configuring Outputs on Output-Specific Pages
The output-specific pages allow configuration of theHDMI output and theHDBT output on an
individual basis. Output settings and automatic power settings can be configured for each output.
In addition, information about the connected display and the output signal can be viewed.

To configureHDMI output settings and to view information about the connected display and
HDMI output signal:

In the navigation bar, click Output and then click HDMI Output. TheHDMI Output page opens.



Product Manual — Doc. 7901C HD-WP-4K-401-C • 23

HDMI Output Page

To configureHDBT output settings and to view information about the connected display and
HDBT output signal:

In the navigation bar, click Output and then click HDBTOutput. TheHDBTOutput page opens.
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HDBTOutput Page

Refer to the following sections for HDMI andHDBT output configuration information.

Configuring HDMI or HDBT Output Settings
In theHDMI Output Settings section of theHDMI Output page or theHDBTOutput Settings
section of theHDBTOutput page, configure the output settings:

1. Enable or disable the output by selecting the Enable or Disable radio button, respectively. By
default, the Enable radio button is selected, allowing the output display to turn on. If the
Disable radio button is selected, the output display turns off.

2. In theHDMI Nameor HDBT Name text box, rename the output if desired. For theHDMI
output, the default name is OUTPUT 1. For theHDBT output, the default name is OUTPUT 2.
To save the new name, click the SaveNamebutton.

3. Select one of the following HDCPMismatch radio buttons if theHDCP settings of one or
moreDigitalMedia devices in the signal path do not support theHDCP version of the source:

l BlankWindow: (Default setting) Displays a blank windowon the output if an HDCP
mismatch exists

l DisableOutput: Turns off the output if an HDCPmismatch exists
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4. In theColor Space drop-down list, select one of the following:

l Auto: (Default setting)Output color spacewill follow sink EDID in the following order
of priority: YUV444, YUV422, RGB.

l Force RGB: Forces the output color space to RGB

l Force Y444: Forces the output color space to YUV444

l Force Y422: Forces the output color space to YUV422

Configuring Automatic Power Settings
In the Automatic Power Settings section of theHDMI Output page or HDBTOutput page, enable
or disable automatic power-off and power-on settings by selecting the Enable or Disable radio
button, respectively. By default, the Enable radio button is selected. If Automatic Power Settings is
set to Enable, continuewith the following steps:

1. In the Power Off section:

a. In the Timeout drop-down list, select the number of seconds that must pass after all
HDMI inputs are disconnected before allowing the output to be turned off
automatically. Available values are the following: 5 seconds, 10 seconds, 15 seconds, 30
seconds, 60 seconds, 90 seconds, andCustom. The default setting is 5 seconds.

If Custom is selected, enter the desired number of seconds in the Timeout text box.
Values range from 0 to 65535 seconds. To save the setting, click the Set button.

b. Specify whether the output is to be turned off according to the timeout value
specified in the previous step. Select the Yes radio button to turn off the output or the
No radio button to prevent the output from turning off.

c. Select one of the Send command radio buttons to choose the interface to send a
power-off command:

l None: (Default setting) Does not send any command

l CEC: Sends the command via CEC (Consumer Electronics Control)

l RS232: Sends the command via RS-232

l IR: Sends the command via IR

NOTE: An IR filemust be loaded under IR Settings on theDevice page before
commands will be available for use in the Automatic Power Settings section
of theHDMI Output andHDBTOutput pages.

If RS232 is selected, click the RS232 setting button. In the RS232 Port Setting dialog
box, select the desired value in the Baud, Data Bits, Parity, Stop Bits, Hardware Flow
Control, and Software FlowControl drop-down lists, and then click Exit.
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d. (Applicable to CEC, RS232, or IR) Do either of the following:

l If the Send command is set to CEC or RS232), enter the desired power-on
command as follows:

o In theCommand text box, enter the command in hexadecimal or ASCII
format.

o In the Terminator drop-down list, select one of the following terminators
to append to the command: None (specifies no terminator), CR (carriage
return), LF (line feed), or CR LF (carriage return followed by a line feed).
The default setting is CR LF.

o Select theHex or Ascii radio button to specify the format of the
command. The default setting is Hex.

l If the Send command is set to IR, select the desired IR Key from the drop-down
list.

e. Click the Save button to save the power-offn settings.

2. In the Power On (Sync Detected) section:

a. Select one of the SendCommand radio buttons to choose the interface to send a
power-on commandwhen an HDMI input is detected:

l None: Does not send any command (default setting)

l CEC: Sends the command via CEC

l RS232: Sends the command via RS-232

l IR: Sends the command via IR

NOTE: An IR filemust be loaded under IR Settings on theDevice page before
commands will be available for use in the Automatic Power Settings section
of theHDMI Output andHDBTOutput pages.

If RS232 is selected, click the RS232 setting button. In the RS232 Port Setting dialog
box, select the desired value in the Baud, Data Bits, Parity, Stop Bits, Hardware Flow
Control, and Software FlowControl drop-down lists, and then click Exit.

b. (Applicable to CEC, RS232, or IR) Do either of the following:

l If the Send command is set to CEC or RS232), enter the desired power-on
command as follows:

o In theCommand text box, enter the command in hexadecimal or ASCII
format.

o In the Terminator drop-down list, select one of the following terminators
to append to the command: None (specifies no terminator), CR (carriage
return), LF (line feed), or CR LF (carriage return followed by a line feed).
The default setting is CR LF.

o Select theHex or Ascii radio button to specify the format of the
command. The default setting is Hex.
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l If the Send command is set to IR, select the desired IR Key from the drop-down
list.

c. Click the Save button to save the power-on settings.

TheHDMI Output andHDBTOutput pages also display information about the connected display
and output signal:

l TheConnectedDisplay section of the page displays the following:
o Sink Detected: Specifies whether the output signal is detected by the connected

display (Yes or No)
o Manufacturer: Specifies the name of themanufacturer of the connected display
o Name: Specifies themodel name of the connected display
o Serial Number: Specifies the serial number of the connected display

l TheOutput Signal section of the page displays the following:
o Transmitting: Specifies whether the output is transmitting a signal to the connected

display:

n Agreen icon indicates that the output is transmitting a signal.

n Agray icon indicates that the output is not transmitting a signal.
o Resolution: Specifies the current resolution of the output
o HDCP: Specifies theHDCP version (1.4 or 2.2) or inactive
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Configuring Network Settings
To configure network settings:

1. In the navigation bar, click Network. TheNetwork page opens.

Network Page

2. Configure network settings as required:

l In theHost name text box, overwrite the existing hostnamewith a name that
identifies theHD-WP-4K-401-C on the network. The hostname is restricted to the
letters a to z (not case sensitive), the digits 0 to 9, and the hyphen.

The default hostname is HDWP401C-xxxxxx, where xxxxxx consists of the last six
characters (excluding punctuation) of theMAC address of the device.

l In theDomain Name text box, enter up to two domain names separated by a comma
and a space.

l Specify whether the IP address of theHD-WP-4K-401-C is to be assigned by aDHCP
(Dynamic Host Configuration Protocol) server. To set the IP address, click either of
the following radio buttons:

o Obtain an IP address automatically: (Default setting) Allows the IP address of
theHD-WP-4K 401-C to be automatically assigned by aDHCP server on the
local area network (LAN) for a predetermined period of time.

NOTE: If a DHCP server does not exist on the network and 5 seconds have
elapsed since theHD-WP-4K-401-Cwas powered on, the IP address defaults
to a link local address. Refer to RFC 3927 for information about link local
addressing.
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o Use the following IP address: Allows a static IP address and associated network
settings to be configured:

n IP Address: Enter a unique IP address for theHD-WP-4K-401-C.

n Subnet Mask: Enter the subnet mask that is set on the network.

n Default Gateway: Enter the IP address that is to be used as the
network’s gateway.

n DNS Server1: Enter the IP address of the primary DNS server.

n DNS Server2: Enter the IP address of the secondary DNS server.

3. Do either of the following:

l To save the current entries, click the Save button. TheHD-WP-4K-401-C
automatically reboots.

l To go back to the previous settings without saving the current entries, click the Revert
button.

Configuring Device Settings
Configuration andmanagement of device settings consist of the following:

l Connecting to aControl System (on the next page)

l Enabling or Disabling the Front Panel (on page 31)

l Changing theUsernameand Password (on page 32)

l Configuring RS232 Port Settings (on page 33)

l Configuring IR Settings (on page 34)

l Updating Firmware (on page 35)

l Updating SSL Files (on page 36)

l Restoring Factory Default Settings (on page 37)

l Rebooting theHD-WP-4K-401-C (on page 37)

To configure device settings:

In the navigation bar, click Device. TheDevice page opens.

Refer to the following sections for information about configuration andmanagement of the
various device settings.



30 • HD-WP-4K-401-C Product Manual — Doc. 7901C

Connecting to a Control System
Configure the connection between theHD-WP-4K-401-C and a control system in theControl
System Connection section of theDevice page.

Device Page—Sample Control SystemConnection

To configure control system connection settings:

1. In the Address or Host Name text box, enter the IP address or host name of the control
system.

2. In the IP ID text box, enter the IP ID of theHD-WP-4K-401-C. Valid values range from 03 to
FE in hexadecimal notation.

3. In the Port text box, enter the port number of theHD-WP-4K-401-C.

NOTE: The default port number is 41794.

4. Do either of the following:

l To save the current entries, click the Save button. Amessage appears, indicating that
theHD-WP-4K-401-Cwill reboot. Click OK to reboot the device.

l To revert to the previous settings without saving the current entries, click the Revert
button.

The Status field (read only) displays the connection status of theHD-WP-4K-401-C to the control
system as Offline or Online.
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Enabling or Disabling the Front Panel
By default, the front panel state of theHD-WP-4K-401-C is enabled, allowing theOLED display
and front panel push buttons (navigation pad,MENU, BACK, and EXIT) to function. In addition, the
front panel LEDs are enabled by default. TheOLED display, front panel push buttons, and LEDs
can be disabled.

Enable or disable the front panel state and LEDs in the Front Panel section of theDevice page.

Device Page—Front Panel

Using the Front Panel State radio buttons, do either of the following:

l To enable theOLED display and front panel push buttons, click the Enabled radio button if it
is not already selected.

l To disable theOLED display and front panel push buttons, click theDisabled radio button.

Using the Front Panel LEDs radio buttons, do either of the following:

l To enable the front panel LEDs, click the Enabled radio button if it is not already selected.

l To disable the front panel LEDs, click theDisabled radio button.

NOTE:When the front panel LEDs are disabled, the PWR andONLINE LEDs turn off. The
HD-WP-4K-401-C appears as though it is not powered on; however, the device remains
powered on and continues to function.
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Changing the Username and Password
Change the usernameand password in theUsernameand Password section of theDevice page.

Device Page—Username and Password

To change the usernameand password:

NOTE: The usernameand password are case sensitive.

1. In theUsername text box, enter the desired username.

2. In the Password text box, enter the desired password.

3. In theConfirm Password text box, reenter the desired password to confirm the password.

4. Do either of the following:

l To save the current entries, click the Save button.

l To go back to the previous settings without saving the current entries, click the Revert
button.
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Configuring RS232 Port Settings
Configure RS232 port settings in the RS232 Port Settings section of theDevice page.

Device Page—RS232 Port Settings

To configure RS232 port settings:

1. In the Baud drop-down list, select the number of bits to be transmitted per second. Available
values are as follows:

300 9600
600 14400
1200 19200
1800 28800
2400 38400
3600 57600
4800 115200
7200

The default setting is 9600bits per second (bps).

2. In theData Bits drop-down list, select the number of data bits that are to be transmitted as
a series. Available values are 7 and 8. The default setting is 8.

3. In the Parity drop-down list, select NONE, Odd, Even, or Mark. The default setting is NONE.

4. In the Stop Bits drop-down list, select 1 or 2. The default setting is 1.

5. In theHardware FlowControl drop-down list, select RTS/CTS or NONE. The default setting
is NONE.

6. In the Software FlowControl drop-down list, select NONE or XON/XOFF. The default
setting is NONE.
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Configuring IR Settings
Load or delete an IR file (*.ir) in the IR Settings section of theDevice page.

Device Page—IR Settings

NOTE:Only one IR file can be loaded at a time. An existing IR filemust be deleted prior to loading
another IR file. To delete a previously loaded IR file, click theDelete button at the bottom of the IR
Settings section of theDevice page.

To load an IR file:

1. Click the Browse button.Windows Explorer opens.

2. Locate and select the desired IR file (*.ir), and then click theOpen button.

3. Click the Load button. A prompt appears asking for confirmation.

4. Click theOK button to load the IR file.

Commands listed in the IR Settings section will be available for use under the Automatic
Power Settings section of theHDMI Output andHDBTOutput pages.
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Updating Firmware
Update firmware in the Firmware section of theDevice page.

Device Page—Firmware

The Firmware section displays the following information about theHD-WP-4K-401-C:

l Model, which is HD-WP-4K-401-C

l Serial Number

l Firmware Version

To update the firmware, click theUpload firmware file radio button or theUse service port radio
button:

l If theUpload firmware file radio button is selected:

1. Click the Browse button.Windows Explorer opens.

2. Locate and select the desired firmware file (*.bin), and then click theOpen button. The
Browse field displays the selected path and firmware filename.

3. Click the Load button. A prompt appears asking for confirmation that the firmware
be updated.

4. Click theOK button to update the firmware.

l If theUse service port radio button is selected:

1. Using a USBmass storage device that contains only the firmware file, insert theUSB
device into the SERVICE port of theHD-WP-4K-401-C.

2. Click the Load button. A prompt appears asking that a USB drive be inserted.

3. Click theOK button to update the firmware.
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Updating SSL Files
Update an SSL Certificate file and SSL Private Key file in the SSL section of theDevice page.

Device Page—SSL

To update an SSL Certificate file:

1. Click the Browse button.Windows Explorer opens.

2. Locate and select the desired SSL Certificate file (*.crt), and then click theOpen button.

3. Click the Load button. A prompt appears asking for confirmation.

4. Click theOK button to load the SSL Certificate file.

To update an SSL Private Key file:

1. Click the Browse button.Windows Explorer opens.

2. Locate and select the desired SSL Private Key file (*.key), and then click theOpen button.

3. Click the Load button. A prompt appears asking for confirmation.

4. Click theOK button to load the SSL Private Key file.
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Restoring Factory Default Settings
Restore factory default settings in theDeviceManagement section of theDevice page.

Device Page—Device Management, Restore

To restore factory default settings:

1. Click the Restore button. A prompt appears asking for confirmation that the default
settings be restored.

NOTE: Clicking the Restore button restores all settings—including the user nameand
password login settings and the network settings—to the factory default settings. If the
user nameand password have been changed, clicking the Restore button reverts the user
nameand password to the default setting, which is admin (refer to Logging In to theHD
WP 4K-401-C (on page 6) for additional information). If a static IP address has been set,
clicking the Restore button reverts the IP address to DHCPmode, which is the default
setting (refer to Configuring Network Settings (on page 28) for additional information).

2. Click OK to restore factory default settings and to reboot the device.

Rebooting the HD-WP-4K-401-C
Reboot theHD-WP-4K-401-C in theDeviceManagement section of theDevice page.

Device Page—Device Management, Reboot

To reboot theHD-WP-4K-401-C:

1. Click the Reboot button. Amessage appears, indicating that the devicewill reboot.

2. Click OK to reboot the device.
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Using the Front Panel OLEDDisplay Menu
When theHD-WP-4K-401-C is powered on andwhenever the front panel OLED display is in an idle
state, theOLED display cycles through the following items on a scrolling basis, displaying two lines
at a time:

HD-WP-4K-401-C
IP address (for example, 172.30.161.59)
1. Input 1 resolution (for example, 3840x2160@30)
2. Input 2 resolution (for example, 1080p@60)
3. Input 3 resolution (for example, 1080p@60)
4. Input 4 resolution (for example, 720p@60))

NOTE: If a source is not connected to an input, theOLED displays None for the input.

TheOLED display provides amenu that enables configuration of theHD-WP-4K-401-C. The
following illustration provides amenu tree of theOLED display.

OLED Display Menu Tree

The following sections provide information about theOLED display menu.
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Accessing and Navigating the OLED Display Menu
To access and navigate theOLED display menu, use theOLED push buttons and the navigation
pad on the front panel of theHD-WP-4K-401-C.

OLED Push Buttons and Navigation Pad

To access themain menu of theOLED display, press theMENU button. TheOLEDmain menu,
which displays two lines at a time, appears as follows.

OLED Main Menu

<<Main Menu >>
Windowing

To navigate themain menu and submenus on theOLED display, do the following:

l To navigate upward in amenu, press the up button (p) on the navigation pad.
l To navigate downward in amenu, press the down button (q) on the navigation pad.
l Tomove the cursor to the left when entering data, press the left button (t) on the
navigation pad.

l Tomove the cursor to the right when entering data, press the right button (u) on the
navigation pad.

l To select an item in amenu, press the Enter button on the navigation pad.

l To save a new setting, press the Enter button on the navigation pad.

l To go back to the previous level in amenu, press the BACK button on the front panel.

l To exit themenu of theOLED display, press the EXIT button on the front panel.
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Configuring Windowing Settings
To configure video windowing settings:

On themain menu, selectWindowing. TheWindowing submenu opens.

Windowing Submenu

<Windowing >
Layout

Available selections are as follows:

Layout
WindowTitles
Audio Selection

Refer to the following sections for information about configuring video window layout, window
titles, and audio selection.

Configuring Video Window Layout
To configure the video window layout:

1. In theWindowing submenu, select Layout.

Windowing Submenu

<Windowing >
Layout

The Layout submenu opens.

Layout Submenu

< Layout >
Layout Select

2. Select Layout Select. The Layout Select list of available options opens.

Layout Select Submenu

< Layout Select>
*Auto

Available Layout Select options are listed in the following table. Refer to the table for
information about each option.
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Layout Select Options

Option Description

Auto Displays the detected inputs as follows:

l Displays four detected inputs as a quad view consisting of four
equal-sizedwindows positioned as two side-by-side windows above
two side-by-side windows

l Displays three detected inputs as three equal-sizedwindows
positioned as two side-by-side windows above one centeredwindow

l Displays two detected inputs as two equal-sized and vertically
centeredwindows

l Displays one detected input as a full-screen image

Full Screen Displays one detected input as a full-screen image

PIP Displays any single input as a full-screen image with any other input as a
scalable inset window that can be positioned as desired. Refer to
ConfiguringWindow Titles (on page 43) for information about PIP options.

Side by Side Displays two inputs as two equal-sized and vertically centeredwindows

3-Up Displays three inputs as three equal-sizedwindows positioned as two side-
by-side windows above one horizontally centeredwindow.

Quad View Displays four inputs as four equal-sizedwindows positioned as two side-
by-side windows above two side-by-side windows

3-Down Displays three inputs as three equal-sizedwindows positioned as two side-
by-side windows below one horizontally centeredwindow.

3-Left, 1-Right Displays four inputs as three equal-sizedwindows on the left and one
larger vertically centeredwindow on the right.

3-Right, 1-Left Displays four inputs as three equal-sizedwindows on the right and one
larger vertically centeredwindow on the left.

An asterisk precedes the current setting. If a layout other than Auto is selected, the
corresponding number of windows is added to the Layout submenu below Layout Select:

l If Full Screen is selected,Window 1 is added.

l If PIP or Side by Side is selected,Window 1 andWindow 2 are added.

l If 3-Up or 3-Down is selected,Window 1,Window 2, andWindow 3 are added.

l If Quad View, 3-Left 1-Right, or 3-Right 1-Left is selected,Window 1,Window 2,
Window 3, andWindow 4 are added.

3. For all layout selections with the exception of Auto, assign each correspondingwindow to
the desired video input:
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a. In the Layout submenu, select thewindow, for example,Window 1.

Layout Submenu

< Layout >
Window 1

TheWindow submenu opens for the selectedwindow.

Window Submenu (Window 1 Shown)

<Window 1 >
INPUT 1

b. Select the desired video input for thewindow. By default, the inputs are listed as
INPUT 1, INPUT 2, INPUT 3, and INPUT 4.

c. Repeat steps 3a and 3b for each window listed in the Layout submenu.
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Configuring Window Titles
To configurewindow titles:

In theWindowing submenu, selectWindowTitles.

Windowing Submenu

<Windowing >
WindowTitles

TheWindowTitles submenu opens.

Window Titles Submenu

<WindowTitles >
WindowTitles

Items on theWindowTitles submenu are listed in the following table. Refer to the table for
configuration guidelines.

Window Titles Submenu Guidelines

Submenu Item Guidelines

Window Titles Controls whether the input name is to be displayed over the corresponding
window:

l Enable: (Default setting) Allows window titles, which display the input
name over the corresponding window

l Disable: Prevents the input name from being displayed over the
corresponding window

An asterisk precedes the current setting.

Titles Position (Applicable only whenWindow Titles is enabled) Select one of the following
options to position window titles: Upper Left (default setting), Center Left,
Lower Left, Upper Right, Center Right, Lower Right. An asterisk precedes the
current setting.
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Configuring Audio Selection
To select the input whose audio is to be unmuted:

In theWindowing submenu, select Audio Selection.

Windowing Submenu

<Windowing >
Audio Selection

TheAudio Selection submenu opens.

Audio Selection Submenu

< Audio Selection >
*Auto

Available selections are as follows:

Auto (Default setting) Audio is transmitted only when a single full-screen image is
displayed in a singlewindowor when the layout is in PIP mode. If multiplewindows
are displayed, audio from all sources is muted.

Input 1 Unmutes audio from input 1
Input 2 Unmutes audio from input 2
Input 3 Unmutes audio from input 3
Input 4 Unmutes audio from input 4

An asterisk precedes the current selection.
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Configuring Input Settings
To configure input settings:

1. On themain menu, select Inputs. The Inputs submenu opens.

Inputs Submenu

< Inputs >
Global EDID

Available selections are as follows:

Global EDID
Input 1
Input 2
Input 3
Input 4

2. Configure inputs by doing either of the following:

a. Select Global EDID to apply the selected EDID to all inputs.

The followingmessage flashes across theOLED: Apply EDID to All Inputs

i. Confirm theGlobal EDID selection by pressing the Enter button. A list of EDID
files is presented.

DMDefault 4k 30Hz 2ch (Default setting)
DMDefault 1080p60 2ch
Laptop 16x10 1280x800 2ch
Laptop 16x10 1920x1200 2ch>
Laptop 16x9 1080P50 2ch
Laptop 16x9 1080P60 2ch
Laptopwidescreen 2ch
Consumer 4k 25Hz HBR 3D
Consumer 4k 30Hz HBR 3D
Consumer 1080P50 3D HBR
Consumer 1080P50HBR
Consumer 1080P60 3D HBR
Consumer 1080P60HBR
Consumer 720P50HBR
Consumer 720P60HBR
External EDID 1
External EDID 2
External EDID 3
External EDID 4
External EDID 5
External EDID 6
External EDID 7
External EDID 8
Copy Output 1
Copy Output 2
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NOTES:

l In the preceding list, External EDID 1 through External EDID 8 represent
placeholders for custom-loaded EDID files.

l Selecting Copy Output 1 or Copy Output 2 copies the EDID from the
output to all of the inputs.

ii. Select the desired EDID.

A prompt appears asking for confirmation that the selected EDID be applied to
all inputs.

iii. Select Yes or No:

l If Yes is selected, the Settingmessage appears, and then theOLED
display returns to the Inputs submenu.

l If No is selected, theOLED display returns to the list of available EDIDs.

b. Configure each input on an individual basis by selecting the input number in the Inputs
submenu.

The Input Status andConfiguration submenu opens for the selected input.

Input Status and Configuration Submenu (Input 1 Shown)

< Input 1 >
Status

Items on the Input Status andConfiguration submenu are listed in the following table.
Refer to the table for configuration guidelines.

Input Status and Configuration Submenu Guidelines

Submenu Item Guidelines

Status (ReadOnly) Indicates whether a source is detected at the input:
Sync On or Sync Off

Name Enables renaming of an input. To rename an input, use the up (p)
and down (q) buttons to enter capital letters, lowercase letters,
numbers, a plus sign (+), aminus sign (-), a left bracket ([), and a
right bracket (]). To move the cursor to the left or right when
renaming an input, press the left (t) or right (u) button,
respectively. To save the name, press the Enter button. The message
Saving… Complete is displayed.
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Submenu Item Guidelines

EDID Displays the current EDID. If an EDID other than the Global EDID is
to be assigned, select the desired EDID. Available selections are as
follows:

DMDefault 4k 30Hz 2ch (Default setting)
DMDefault 1080p60 2ch
Laptop 16x10 1280x800 2ch
Laptop 16x10 1920x1200 2ch
Laptop 16x9 1080P50 2ch
Laptop 16x9 1080P60 2ch
Laptopwidescreen 2ch
Consumer 4k 25Hz HBR 3D
Consumer 4k 30Hz HBR 3D
Consumer 1080P50 3D HBR
Consumer 1080P50 HBR
Consumer 1080P60 3D HBR
Consumer 1080P60 HBR
Consumer 720P50 HBR
Consumer 720P60 HBR
External EDID 1
External EDID 2
External EDID 3
External EDID 4
External EDID 5
External EDID 6
External EDID 7
External EDID 8
Copy Output 1
Copy Output 2

When an EDID is selected, the Settingmessage is displayed.

NOTES:

l In the list above, External EDID 1 through External EDID 8
represent placeholders for custom-loaded EDID files.

l Selecting Copy Output 1 or Copy Output 2 copies the EDID
from the output to all of the inputs.

HDCP Assigns the HDCP version or disables HDCP. Select HDCP 2.2,
HDCP 1.4, or Disable. The default setting is HDCP 2.2. An asterisk
precedes the current setting.
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Configuring Output Settings
To configure output settings:

1. On themain menu, select Outputs. TheOutputs submenu opens.

Outputs Submenu

< Outputs >
Output 1

Available selections areOutput 1 andOutput 2.

2. Configure an output by selecting the output in theOutputs submenu. TheOutput
Configuration submenu opens for the selected output.

Output Configuration Submenu (Output 1 Shown)

< Output 1 >
Status

Items on theOutput Configuration submenu are listed in the following table. Refer to the
table for configuration guidelines.

Output Configuration Submenu Guidelines

Submenu Item Guidelines

Status (ReadOnly) Displays the manufacturer, model, and serial number of the
connected display. If no display is connected, the status is displayed as
Inactive.

Name Enables renaming of an output. To rename an output, use the up (p) and
down (q) buttons to enter capital letters, lowercase letters, numbers, a
plus sign (+), aminus sign (-), a left bracket ([), and a right bracket (]). To
move the cursor to the left or right when renaming an output, press the
left (t) or right (u) button, respectively. To save the name, press the
Enter button. The message Saving…Complete is displayed.
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Configuring Network Settings
To configure network settings:

On themain menu, select Network. TheNetwork Status andConfiguration submenu opens.

Network Status and Configuration Submenu

< Network >
Status

Available selections are as follows:

Status
DHCP
DHCP Renew (Displayed only if DHCP is set to ON)
IP Setup (Displayed only if DHCP is set to OFF)
DNS Server 1
DNS Server 2

Items on theNetwork Status andConfiguration submenu are listed in the following table. Refer to
the table for configuration guidelines.

Network Status and Configuration Submenu Guidelines

Submenu Item Guidelines

Status (ReadOnly) Provides the following network-related information:

l DHCP: Indicates whether DHCP is on or off

l IP Address: Displays the IP address of the HD-WP-4K-401-C

l SubnetMask: Displays the subnetmask that is set on the network

l Gateway: Displays the IP address that is used as the network’s gateway

l DNS Server 1: Displays the address of the primary DNS server

l DNS Server 2: Displays the address of the secondary DNS server

l MAC Address: Displays the MAC address of the HD-WP-4K-401-C

DHCP Set DHCP to ON or OFF. The default setting is ON. An asterisk precedes the
current setting.

DHCP Renew (Displayed only if DHCP is set to ON) Select DHCP Renew to obtain a new IP
address lease.

IP Setup (Displayed only if DHCP is set to OFF) Enter the following network-related
information:

l IP Address: Enter a unique IP address for the HD-WP-4K-401-C.*

l SubnetMask: Enter the subnetmask that is set on the network.*

l Gateway: Enter the IP address that is used as the network’s gateway*

DNS Server 1 Enter the address of the primary DNS server.*
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Submenu Item Guidelines

DNS Server 2 Enter the address of the secondary DNS server.*

*To enter an address, use the navigation pad. Press the up (p) and down (q) buttons as appropriate to
enter each octet in an address. To move to the previous octet in an address, press the left (t) button. To
move to the next octet in an address, press the right (u) button. To save an address, press the Enter
button.

Configuring Device Settings
To configure device settings:

On themain menu, select Device. TheDevice Status andConfiguration submenu opens.

Device Status and Configuration Submenu

< Device >
Details

Available selections are as follows:

Details
Front Panel
FirmwareUpdate
Restore

Items on theDevice Status andConfiguration submenu are listed in the following table. Refer to
the table for configuration guidelines.

Device Status and Configuration Submenu Guidelines

Submenu Item Guidelines

Details (ReadOnly) Displays the following information about the HD-WP-4K-401-C:

l S/N: Specifies the serial number of the HD-WP-4K-401-C

l FWVer.: Specifies the firmware version of the HD-WP-4K-401-C

Front Panel Selecting Disable disables the OLED display and front panel push buttons
(navigation pad, BACK, and EXIT buttons).

NOTE: To enable the OLED display and front panel push buttons, press and
hold the MENU push button for 3 seconds.
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Submenu Item Guidelines

Firmware Update When Firmware Update is selected, a prompt appears asking for confirmation
that the firmware be updated. Select Yes or No. If Yes is selected, insert a USB
mass storage device containing the updated firmware file into the SERVICE
port. The update process begins and the followingmessage appears on the
OLED display:

Upgrade in process
Do not remove power

When the update process is complete, the OLED displays the model name (HD-
WP-4K-401-C) and the IP address of the HD-WP-4K-401-C.

Restore When Restore is selected, a prompt appears asking for confirmation that the
default settings be restored.

NOTE: Restoring the HD-WP-4K-401-C to factory default settings restores all
settings—including user name and password settings and network settings—to
factory default settings.

Select Yes or No. If Yes is selected, the Restoringmessage appears followed by
the Restoring…Complete message.
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